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MOVING-MAP COMPOSER-PERSONAL COMPUTER (MMCPC) VERSION 1.0 FOR
THE FINLAND AIR FORCE: SOFTWARE USER’S MANUAL

1. INTRODUCTION

This report documents a substantial revision of the Moving-Map Composer (MMC) system designed
and developed by scientists at the Naval Research Laboratory (NRL) Geospatial Processing and Analysis
(GeoPAL) Team (Code 7440.1). This version of MMC has been extended for use on personal computers
(PCs) and is referred to as MMCPC. This is the first edition of the MMCPC Software User’s Manual, to
be distributed with MMCPC software release 1.0. MMCPC is specifically designed and configured to
support Finland Air Force (FiAF) F/A-18 mission planners and pilots in the field.

MMCPC is a software application developed for installation on a Windows XP computer configured
with a standard 16-bit PCMCIA (Personal Computer Memory Card International Association) drive, or
PC card drive, for reading and writing Tactical Aircraft Moving-Map Capability (TAMMAC) mission
and theater map data loads. MMCPC enables users to perform the following functions:

e Process FiAF source Geo-referenced Tagged Image File Format (GeoTIFF) files into a Compressed
Arc Digitized Raster Graphics (CADRG)-compatible format;

e Process FiAF or National Geospatial-Intelligence Agency (NGA) source Digital Terrain Elevation
Data (DTED) into a TAMMAC-compatible regridded DTED format (RDTED);

e Define and save regions of interest (ROIs) for mission and theater map data loads as a series of
bitmap representations;

e Populate these regions of interest with data from user-specified FiAF GeoTIFF files (converted to
CADRG-like files via MMCPC), NGA CADRG, FiAF and/or NGA RDTED, and NGA Controlled
Image Base (CIB) databases;

e Import and convert non-georeferenced images into TAMMAC-compatible data frames;

e Write completed TAMMAC theater map data loads to PC cards for aircraft loading;

e Build Mission Planning loads from user-specified CADRG, RDTED, CIB, and data frames;
e Print final compositions, CADRG images, data frames, and map load summaries.

2. SYSTEM CONFIGURATION

Figure 1 illustrates the FIAF MMCPC operational components, the data flow between each of these
components, and the principal MMCPC software operations: defining geographic regions of interest,
inputting data sources, and building mission and theater map data loads from the resulting map
compositions.

Map compositions are user-defined regions of interest based on logged sources for CADRG, CIB, and

RDTED map data, as well as combinations of existing user-defined compositions and data frames. Figure
2 outlines how to create a new map composition.

Manuscript approved December 10, 2007.
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The main body of this manual provides detailed information on the MMCPC software. Section 3
describes the graphical user interface (GUI), including the world-map workspace, tool bars, and all
associated utilities. Section 4 provides step-by-step instructions on how to perform the most common
operations. Acronyms and terms are defined in Appendix A.

Composition GeoTIFF

.!'I' 7 =

~D -

oo o w
D

Process Data
(CADRG, RDTED)

LT
FiAF =
DTED g‘ i

¥ L 4
ﬁ \ Log Data
into

MMCPC

Define MMCPC composition

!

Compile Map Data for TAMMAC
Theater or Mission Load —1

[ \._
Theater Load Mission Load | ' & )

¥ L J

TAMMAC Mission Planning
PC Cards System

Fig. 1 — FiAF MMCPC operational components
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Fig. 2 — Building a user-defined mission or theater composition
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3. GRAPHICAL USER INTERFACE

3.1 Starting MMCPC

MMCPC is invoked by double-clicking its application icon on the PC desktop or through the Start >
Programs menu. This brings up the main MMCPC window (Fig. 3).

Section 3.2 provides detailed descriptions and illustrations of the workspace, menus, tools, and title
bar. Section 3.3 provides detailed descriptions of operations accessed from the main menu.

3.2 Toolbars and Workspace Definitions
3.2.1 World-map Workspace
Figure 3 depicts the main MMCPC window, primarily consisting of a world base map, in Mercator

projection, on which to design mission and theater compositions. The currently open composition file
name (e.g., “FINLAND 1 Edition 1” in Fig. 3) is displayed in the title bar of the main MMCPC window.

Main B FINLAND1 Edition 1 Unlocked - MMCPC v1.0
Menu

File Edit Yiew Process Log Compose Build System Help
Tool _ N B | o= |, * ¢ -8 [([I0xNQxL |5 4
Bar

World-map _|
workspace

= — LAT ;-84 2 5351
LOM : B3 28 1587

Composing Mode

Fig. 3 — Main MMCPC window

The cursor latitude/longitude position box (located in the lower right corner of the workspace) shows
the current geographic position of the cursor over the MMCPC base map. Position is shown in degrees,
minutes and seconds [default] or in decimal degrees of latitude and longitude.

Shortcuts for common base map operations are available by clicking the right mouse button over the
map to invoke the shortcut selection window (Fig. 4):
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Full View to restore the world base map to full view (e.g., following a zoom operation).

Zoom by Stretch Box to zoom into a region of interest using the “stretch-box” tool (Section 3.2.2.3).
View RPF Data to display geographic areas of coverage for Raster Product Format (RPF) data,
including CADRG, CIB, or RDTED.

Hide Lat/Lon Display to toggle on/off the cursor latitude/longitude position box.

File Edit Miew Process Log Compose Build Swstem Help

Y ] foeome =Mz =] % & - [

e

Full Yigw

Zoarn By Stretch Boo

Views RPF Daka

Fig. 4 — Base map shortcuts (access by clicking right mouse button anywhere on map)

3.2.2 Tool Bar

MMCPC provides tools to quickly access common operations, also available through main menu
options. This section describes the functionality of each tool group. The descriptions that follow are keyed
to the tool bar illustrated in Fig. 5:

1. File buttons (Section 3.2.2.1)

2. Data type and scale boxes (Section 3.2.2.2)
3. Zoom buttons (Section 3.2.2.3)

4. Coverage definition buttons (Section 3.2.2.4)
5. Mission and theater buttons (Section 3.2.2.5)
6. Associated data frames (Section 3.2.2.6)

1 2 3 4 5
De @) me =m0 BNk # &
Dizazzociate \-"iewl ﬂ}. 6

Fig. 5— MMCPC tool bar with all selectable options displayed
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MMCPC displays the name of a toolbar button in a screen tip when the mouse pointer rests on the
button. Tool bar fields may be selectively included or removed from view in the main window. Place the
mouse cursor within any of the toolbars and click the right mouse button to invoke the tool bar view
selection window (Fig. 6). Select a viewing preference by placing a check mark next to the desired tool
bars.

I ACOMP Edition 1 Unlocked - MMCPC v1.0
File Edit Wiew Process Log Compose Buld Swstem Help

Dol o g o B

iy By
v  Standard
v Dakatype
e
= e v Arale
FE
AT v Composition Toals .
s
| v [Map Build
|
i - Assorisked Dakaframes
g
I t T .
§ y ‘ Line up
i -‘

*‘? ..-. .l: %’

Fig. 6 — MMCPC tool bar view selection

¥, e tar

3.2.2.1 File Buttons

The File buttons (Fig. 7) are shortcuts for common operations also available via the File menu
(Section 3.3.1), including opening new or existing files and performing save operations. File buttons may
be selectively included or removed from the tool bar by clicking the mouse right-button and toggling the
Standard tool button on/off (adding or removing the check mark; see Fig. 6).

B Untitled - MMCPC v1.0

— - LAT:-53 3 28.26
| LON:-117 1 29.26

Composing Mode

Fig. 7 — File buttons: Create composition, Open file, Save file, Import/Export
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The Create a New Composition button creates and opens a new file in preparation for
building a new mission or theater composition (see Section 3.3.1.1).

The Open an Existing File button opens an existing composition file (see Section
3.3.1.2).

=
E The Save File button saves an open composition file (see Section 3.3.1.4).
Ao

The Import/Export button imports mission compositions in ASCII file format (see
------ Section 3.3.1.6).

3.2.2.2 Data Type and Scale Boxes

Select the map data type and map scale from these drop-down lists (Fig. 8). Users can define
coverages in one series and switch to another series without losing what they defined in the first. Users
can also cut or copy coverages from one series and paste them into another (see Edit menu options Cut,
Copy, and Paste in Section 3.3.2).

M aComp Edition 1 Unlocked - MMCPC 1.0

File Edit Yiew Process Log Compose Build System Help

e B

Disassociate

=k
LAT : -9.5764
LOM : 64.5248

Composing Mode

Fig. 8 — Map data type and scale boxes
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Choose a map Data Type from this drop-down list: CADRG [default], RDTED,
CADRG » | and CIB (including NGA data frames, and FiAF GeoTIFF).

m Choose the map Data Scale from this drop-down list: for CADRG data select one
of the following scales: 1:5M, 1:2M, 1:1M, 1:500k, 1:250k, 1:100k, 1:50k, and
1:12.5k [default]; for RDTED data select 150m [default] or 750m; for CIB data
select Sm [default] or 10m.

3.2.2.3 Zoom Buttons

To optimize performance, the user is advised to zoom-in to a region of interest before designing a
composition or adding overlays. The Zoom buttons (Fig. 9) allow the user to zoom into (or out from) an
area of interest on the MMCPC base map. Zooming can be done via a stretch-box or by selecting a zoom
factor and then zooming in or out by that factor. Note: when a button's icon is gray, it is not available
for use. For instance, the Zoom-out button will be unavailable until the user has zoomed in.

I Untitled - MMCPC v1.0

File Edit Wiew Process Log Compose Buld System H
Do @ e~ -, 8 S
e e
e
%
&
% ﬂ?ﬂ:&-
- - LAT: 83 3 2826
LON:-117 1 2925
Composing Mode
Fig. 9 — Zoom buttons
,?/ The Zoom-in to ROI via factor box button adjusts the zoom factor with the pop-up
P 0 magnification selection box (Fig. 10). The default magnification (100%) displays the
adl entire world base map. Factor values of 75% or less will zoom-in centered to the point

selected.
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I 7oom EJE|

g LLw

e e R
o
I

Ok Cancel |

Fig. 10 — Zoom factor selection box

i The Zoom-in on a Point button zooms in to the MMCPC base map. Click on this
P 1 button, adjust the zoom factor, and then click on the map to zoom-in (the map will
rd center on the selected point). This button will turn light gray when the maximum

zoom-in has been reached.

The Zoom-out from a Point button zooms out from the MMCPC base map. Click on
this button, and then click on the map to zoom-out (the map will center on the selected
= | point). This button will appear light gray when it is unavailable (i.e., if the user has not
yet zoomed in).

The Zoom-in on a Stretch-Box button zooms in to an area of interest with a stretch-box.
RI:I Click on this button, then click on the upper left corner of the area of interest with the
left mouse button, holding the mouse button down and dragging the resulting stretch-
box to the lower right corner of the area of interest. As long as the mouse button is held
down, the stretch-box may be adjusted. The box maintains a constant aspect ratio
identical to the display screen. As soon as the box is satisfactory, release the mouse
button, and then click again with the left mouse button to perform the zoom (Fig. 11).
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M aComp Edition 1 Unlocked - MMCPC v1.0 (=03
File Edit Yiew Process Log Compose Buld System Help

= = LAT:-56 8 34.239
LON: 179 34 17.14

‘Camposing Mode
(a) posing

B aComp Edition 1 Unlocked - MMCPC v1.0
File Edit Yiew Process Log Compose Build System Help

O & B[] =l =% DONONS | & &

LAT 42 43 4286
w A . |uow:33sas
(b) Composing Made

Fig. 11 — Zooming in to an area of interest: (a) before zoom, (b) after zoom.

3.2.2.4 Coverage Definition Buttons

The Coverage Definition buttons (Fig. 12) allow a user to define coverage areas in three main ways:
1) using the mouse to draw a stretch-box around a coverage; 2) entering a series of lat/lon points to define
a polygon; and 3) picking individual data segments.
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B Untitled - MMCPC v1.0 =13
File Edit ‘jew Process Log Compose Build Swstem Help

B - 1SSy

— . LAT 83 3 2625
LOM: 117 1 23.26

Composing Mode

Fig. 12 — Coverage definition buttons

3.2.2.4.1 Define Area of Coverage

Use any combination of these three buttons to define an area or areas of map coverage for inclusion in
a theater or mission composition.

1
Rl

The Define Coverage by a Stretch-Box button defines a rectangular area of coverage
using a stretch-box. Click this button, then click on the upper left corner of the area to
be defined with the left mouse button. Hold the mouse button down and drag the

resulting stretch-box to define the desired area. As long as the mouse button is
depressed, the stretch-box is adjustable. Release the mouse button when the box is
satisfactory. Click again (anywhere on the map) with the left mouse button to accept
the coverage and fill the box with segments.

The Define Coverage by Clicking Polvgon Vertices button defines an irregularly
shaped area. Click this button, and then click a series of points (with the left mouse
button) on the world map to define the vertices of a polygon, which in turn defines the

coverage area. To close the polygon and fill the defined area with segments, double-
click with the left mouse button.
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The Define Coverage by Latitude/Longitude Coordinates button defines an area
)‘Hﬁ bounded by specific latitude and longitude points. When a user clicks this button, a

Latitude/Longitude Entry window (Fig. 13) pops up. Enter each geographic coordinate
pair (latitude, longitude), then click Add LAT/LON. As each pair is added, MMCPC
will list it in the Latitude/Longitude Entry window. The user can edit the entries as
follows before accepting the coverage area:

e To edit a record, select the entry in the list (the Add LAT/LON button will
automatically rename to Change LAT/LON), edit the latitude and/or longitude
value(s) and click Change LAT/LON.

o To delete a record, select the entry in the list and click Remove LAT/LON.

e  When all coordinates are listed correctly, click OK. The main MMCPC window
will return, and the defined composition will appear on the world map.

e To exit from the Latitude/Longitude Entry window and not save the points as a
composition, click Cancel. The main MMCPC window will return.

R
Dl |l =i <%t - @ 0= A
Disassociste | Wiew| — |
I L AT LON Entry BIx
LaT Lon | |
| | [
<
Add LAT/LON | Fiemove LAT/LON |
=

Ok Cancel a
Rt

e e
Fig. 13 — Latitude/Longitude entry window

3.2.2.4.2 Erase an Area of Coverage

These buttons are deactivated until the user has defined at least one area of coverage with one or more
of the Define Coverage buttons (Section 3.2.2.4.1). Use any combination of the following three buttons to
erase areas of map coverage (i.e., remove coverage from a theater or mission composition).

The Erase Coverage by a Stretch-Box button erases a rectangular area of coverage in
the same way that the Define Coverage by a Stretch-Box button works (Section
3.2.2.4.1).
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The Erase Coverage by Clicking Polygon Vertices button erases an irregularly shaped
area in the same way that the Define Coverage equivalent works (Section 3.2.2.4.1).

The Erase Coverage By Latitude/Longitude Coordinates button erases an area bounded
by specific latitude and longitude points in the same way that the Define Coverage
equivalent works, using the Latitude/Longitude Entry window (Section 3.2.2.4.1).

3.2.2.4.3 Set/Clear Individual Segments

4

The Set/Clear button individually selects segments to be added to—or deleted from—a
composition. In other words, this button acts as a toggle to select and deselect
individual segments.

3.2.2.5 Mission/Theater Buttons

The Mission/Theater buttons (Fig. 14) are shortcuts for common operations also available via the
Build menu (Section 3.3.7), including building map loads and writing them to PC card(s).

File Edit Wiew Process Log Compose Build Systemn Help

N Lntitled - MMCPC v1.0

—— LAT: 63 3 28.26
LON:-117 1 29.26

Composing Made

Fig. 14 — Mission/Theater buttons
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The Build a Map button builds a theater or mission map load (see Section 3.3.7.1).

The Write a Theater Map button writes a mission/theater load to a PC card (see
Section 3.3.7.2).

3.2.2.6 Associated Data Frames

This tool displays a drop-down menu that lists every data frame associated with the current
composition (Fig. 15). See Section 3.3.6.2 for information regarding how to associate data frames with
the current composition. Use this tool to verify the data frames have been properly associated with a
composition. To view a data frame, select it from this menu, and click the View button to the left of the
data frame list. Click the Disassociate button to remove an entry from the list.

B aComp Edition 1 Unlocked| - MMCPC v1.0

File Edit Yew Process Log Compose Build Swstem Help

=k .

LAT : 50,0000
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Fig. 15 — Data frame tool showing associated data frames
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3.3 Main Menu
The top menu bar (main menu) provides drop-down menus for the main operations of MMCPC.
3.3.1 File

The File menu (Fig. 16) lets a user create, open, and save a composition, and exit from MMCPC.

B aComp Edition 1 Unlocked - MMCPC ¥1.0
File Edit View Process Log Compose Build Swskem Help

Y mew ChriN = |[5m ][

'}

= Cpen Chrl4+C
Close

H Save Chrl+5
Save hs...

| Import | Export

- Print. .. Chrl+P

Exit

Fig. 16 — File menu

3.3.1.1 New (Ctrl-N or Alt-FN)

This option—also available via the Create a New Composition button on the tool bar (Section
3.2.2.1)—=creates a new file in preparation for building a mission or theater build. See the Open option
(below) for alternatives to New. If a user designs a composition and does not save it before selecting New,
MMCPC will issue a warning to save the work prior to starting a new file.

3.3.1.2 Open (Ctrl-O or Alt-FO)

This option—also available via the Open an Existing File button on the tool bar (Section 3.2.2.1)—
opens a file containing a mission or theater build composition. When the user selects Open, MMCPC
displays a list of compositions from which to choose (Fig. 17), after which MMCPC returns to the base
map and displays the selected composition (Fig. 18). At this point, the user can view the map data defined
by the composition (via the View RPF Data selection from the right mouse button menu) or modify the
composition.

3.3.1.3 Close (Alt-FC)

This option closes the current composition and refreshes the main MMCPC window. If the user has
made unsaved changes, MMCPC will issue a warning and provide an opportunity to save the work prior
to closing.
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Fig. 17 — Sample list of compositions
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Fig. 18 — Sample composition displayed on the MMCPC base map

3.3.1.4 Save (Ctrl-S or Alt-FS)

This option—also available via the Save File button (Section 3.2.2.1)—saves the current composition
as a working file, with no associated mission or theater specifics. MMCPC does not place any size
restrictions on these files, so the user may save a large “master” composition as a working file, and then
break it into smaller compositions for final files.

MMCPC prompts the user for the final filename, which must be 10 characters or less with only
Modified ASCII (MASCII) alphanumeric characters (i.e., A—Z, 0-9). The full MASCII symbol set is
provided in Appendix B. Note that if the status of the file is locked, it cannot be overwritten and must be
saved as a new edition or given a different name. A composition is always saved in an unlocked state,
which indicates the composition has neither been used to create a TAMMAC theater or mission map load,
nor has it been defined as either a mission or theater map build. Once a composition has been successfully
used to create a TAMMAC map load, MMCPC automatically changes the state of the composition to
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locked, after which no changes can be made to that edition of the composition. This process enables the
MMCPC user to exactly replicate a TAMMAC map based on its corresponding locked composition.
When map sources are removed from MMCPC, any locked compositions referencing those sources will
automatically be marked obsolete, indicating a TAMMAC map build may no longer be exactly replicated
because one or more map sources are no longer available. If the user tries to save a composition with an
unlocked composition filename that already exists, MMCPC will ask if the user wants to overwrite the
preexisting file.

3.3.1.5 Save As (Alt-FA)

This option saves the current composition with a new filename in an unlocked state. MMCPC does
not place any size restrictions on these compositions, so the user may save a large “master” composition
and later break it into smaller compositions for TAMMAC map builds. Filename restrictions are
described in Section 3.3.1.4.

3.3.1.6 Import/Export (4l+-FI)

This option—also available via the Import/Export button (Section 3.2.2.1)—imports mission
compositions in ASCII format. The default directory for import files is C:\MMCPC\MPORT. The export
portion of this function is not supported in MMCPC v1.0.

3.3.1.7 Print (Ctrl-P or Alt-FP)

This option print the contents of the screen.

3.3.1.8 Exit (4It-FX)

This option closes the current composition and exits from MMCPC. If the user has made unsaved
changes, MMCPC will issue a warning and provide an opportunity to save the work prior to closing.

3.3.2 Edit

The Edit menu (Fig. 19) provides utilities to select, cut, copy, and paste coverages between scales.
These options can also be invoked via shortcuts and/or hot keys.

B CCOMP Edition 1 Unlocked - MMCPC v1.0
File | Edit “iew Process Log Compose Build Swstem Help

E Cub Chrlx ED j |15Elm j %

Copy  CUH G Tata\datahrame\FAF bl
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Fig. 19 — Edit menu
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3.3.2.1 Cut (Ctrl-X or Alt-ET) / Copy (Ctrl-C or Alt-EC) |/ Paste (Ctrl-V or Alt-EP)

Cut removes the selected coverage from the current chart series and temporarily stores it in memory
(to be pasted in another series, if desired). Copy makes a copy of the selected coverage and stores it in
memory. Paste adds the most recently cut or copied coverage from memory onto the current coverage.

To select one or more coverages to cut or copy, double-click on each area and they will turn yellow.
Then choose Cut or Copy. Warning: only the most recent Cut or Copy operation stays in memory. If the
user cuts one coverage and then cuts or copies another coverage—before pasting the first—the first
coverage will be overwritten in memory.

3.3.3 View

The View menu (Fig. 20) includes options to refresh the display and overlay shorelines, latitude and
longitude grid, user-defined coverage polygons, available data coverages, and zoom. Some options are
selected with a toggle button that shows a check mark when chosen. These options can also be invoked
via hot keys.

3.3.3.1 World Map (Alt-VW)
World Map is the base map for MMCPC and a standard product from the National Imagery and

Mapping Agency (NIMA). This overlay draws the shorelines of the world and is ON by default (Fig. 21).
When this option is toggled off, MMCPC will not draw the World Map.

B CCOMP Edition 1 Unlocked - MMCPC ¥1.0
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Fig. 20 — View menu
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Fig. 21 — MMCPC base world map

3.3.3.2 LAT/LON Grid (Alt-VG)

This option displays a user-defined grid of latitude and longitude lines (OFF by default). When the
user turns this overlay ON, MMCPC will overlay the grid on the World Map. Default grid spacing is 45°
(latitude and longitude), but the user can change this (see Section 3.3.3.6). Fig. 22 shows the LAT/LON
Grid ON with a 20° grid.
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Fig. 22 — MMCPC base map with latitude/longitude grid overlay ON
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3.3.3.3 Available Coverage (Alt-VC)

This option displays all logged data coverage for the current map type and scale. All available
coverage is shown in green (Fig. 23). The user may click through the data type and map scale drop-down
boxes (Fig. 8) to see the available coverage at each data type and scale. This overlay is OFF by default.

.zl
Fig. 23 — Available coverage of data sources overlay

3.3.3.4 Zoom Options (Al+-VZ)

These options allow a user to zoom into (or out from) an area of interest on the world base map with
zoom tool buttons (Fig. 9). Zooming can also be performed by clicking on one of the zoom icons on the
tool bar (see Section 3.2.2.3).

3.3.3.5 Refresh (Ctrl-H or Alt-VR)

This option redraws the current map information in the MMCPC window.

3.3.3.6 Properties

The Properties option allows adjustment of geospatial coordinate grid spacing and display format.

LAT/LON Grid Spacing: This window (Fig. 24) allows the user to adjust the grid spacing of
geospatial coordinates (the default is 45° in latitude and longitude).
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Fig. 24 — Space adjustment of latitude and longitude grid lines

LAT/LON Format: This window (Fig. 25) allows the user to change the default latitude and longitude
format from degrees, minutes, and seconds to decimal degrees for display of the cursor’s geospatial

position on the MMCPC base map.
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Fig. 25 — Adjustment of latitude and longitude coordinate format

3.3.4 Process

The Process menu (Fig. 26) provides utilities to create CADRG, RDTED, and Data Frames from
FiAF source data. These options can also be invoked via shortcuts and/or hot keys.
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Fig. 26 — Process menu

3.3.4.1 CADRG (Ctrl-G or Alt-PC)

This selection provides options for CADRG data processing. CADRG data is processed from source
FiAF GeoTIFF data and formatted for use in creating TAMMAC theater and mission loads. Once
processed, this data is available for future use with other compositions. See Section 4.3.2 for more details
concerning CADRG data processing.

3.3.4.2 RDTED (Ctrl-D or Alt-PR)

This selection provides options for RDTED data processing. DTED data is processed into RDTED at
750m (1:5M) and 150m (1:1M) resolutions and both scales are automatically included when defined in a
composition. See Section 4.3.1 for more details concerning DTED data processing.

3.3.4.3 Dataframe (Ctrl-F or Alt-PD)

This selection provides options for data frame processing. Data frames are non-georeferenced images
that must be converted to Harris Data Frame (HDF) format. Like CADRG and RDTED data, they can be
included as part of mission and theater loads. See Section 4.3.3 for more details concerning data frame
processing.

3.3.5 Log

The Log menu (Fig. 27) provides utilities to catalog data in the MMCPC source database. These
options can also be invoked via shortcuts and/or hot keys.
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File Edit View Process Log Compose Buld Swstem Help
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Fig. 27 — Log menu

3.3.5.1 Log Source (Ctrl-L or Alt-LL)

This option logs new sources in the MMCPC source database. A browser allows data to be logged
from CD-ROM, the hard disk, or networked sources (Fig. 28). Processed data on the hard disk is
automatically logged; all other data must be logged via the Log function. While logging in a new data
source, MMCPC will build a bitmap of the source to calculate and overlay available coverages. (See
Section 4.2 for more information on loading, selecting, and reading source data).

File Edit Wiew Process Log Compose Build System Help

De @E|IE A6 )% 5, LN e ||

Select Data to be Logged:
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.

Log Cancel

47

Fig. 28 — Log source data window

3.3.5.2 Unlog Source (Alt-LU)

This option removes references to source data from the MMCPC log file (Fig. 29), if (for example) a
previously logged source is found to be bad (e.g., an unreadable CD-ROM) or when older map data
becomes obsolete. Un-logging map data will render obsolete any compositions that included that data.
The unlog function should be used primarily to manage the obsolescence of map data. This will, in turn,
allow MMCPC to automatically manage the state of MMCPC compositions.
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Fig. 29 — Unlog source data window

3.3.6 Compose

The Compose menu (Fig. 30) provides utilities to create and modify compositions.

B MMCPC v1.0

File Edit Wiew Process Log .il:.ll'ﬁl:ll:;SE. Build System Help

: D = n :L | CIE Include Coverage  »

dssociakbe DF

YWerify Composition

T

Fig. 30 — Compose menu

3.3.6.1 Include Coverage (Alt-CC)

This option allows the user to include logged sources or other compositions in the construction of a
composition (Fig. 31).
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Il ACOMP Edition 1 Unlocked - MMCPC +1.0
File Edit View Process Log | Compose Build System Help
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Fig. 31 — Compose menu, Include Coverage option

3.3.6.1.1 Logged Source

This option provides the capability to include logged sources in the construction of a composition.
Valid source coverages include CADRG, RDTED, and CIB data that have been previously logged into
MMCPC. All processed map data is automatically logged upon completion of processing and are valid
sources for selection. MMCPC will present a lit of logged sources available for selection. To select
multiple logged sources at once, click one logged source, then depress the CTRL or SHIFT key while
clicking on others.

3.3.6.1.2 Composition

This option provides the capability to include other compositions in the creation of a new
composition. MMCPC will present a list of available compositions for user selection. Valid composition
file types are locked, unlocked, and obsolete; users may select any of these files. To select multiple
compositions at once, click one composition, then depress the CTRL or SHIFT key while clicking on
others.

3.3.6.2 Associate DF (Alt-CA)

This option associates data frame files with the active composition. The default directory for data
frames is C:\MMCPC\DATA\DATAFRAME. A maximum of 100 files may be associated with a
composition. To select multiple data frames at once, click one data frame, then depress the CTRL or
SHIFT key while clicking on others. The order in which the data frames are stored on the TAMMAC map
load may be changed during the mission/theater build.

3.3.6.3 Verify Composition (A/t-CV)

This option verifies that the active composition is within the proper size constraints for a TAMMAC
map load. The user chooses by radial button whether to verify the composition as a theater map build or
as a mission map build. The PC cards are different for mission loads and for theater loads. Currently,
mission loads have a maximum capacity of 256 MB (single card), and theater loads have a maximum
capacity of 3 GB (maximum of 7 cards). If the composition is within the maximum size constraints, the
user can continue and use it for a map build. If the composition exceeds the required limits, the user must
make modifications (e.g., delete data) until it is within size constraints for the selected map load type prior
to building the TAMMAC map load.
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Note: MMCPC performs a final verification of the selected composition as part of the map build.
Therefore, this size verification procedure is not required but is provided as an informational tool for
use in constructing a composition.

3.3.7 Build

The Build menu (Fig. 32) provides utilities to create TAMMAC mission and theater loads. Some of
these options can also be invoked via shortcuts and/or hot keys.

Bl ACOMP Edition 1 Unlocked - MMCPC w1.0

File Edit Wiew Process Log Compose | Build System Help

3 * CIE - » Build Map hrl+E
H L 1

2 Write Theater Map

Theater Mission Surrary

Fig. 32 — Build menu

3.3.7.1 Build Map (Ctri-B or Alt-BB)

This function—also available via the Build a Map button (Section 3.2.2.5)—acquires the necessary
map data represented by the selected composition and writes that data into its TAMMAC-ready format. If
the current composition has not been saved, a prompt will appear to save and name the composition
before proceeding. A locked or unlocked composition may be selected to create a TAMMAC map load
via the browse button, and the map build type (theater or mission) must be selected. See Section 4.5 for
additional information on building and writing map data.

3.3.7.2 Write Theater Map (A4lt-BW)

This function—also available via the Write a Theater Map button (Section 3.2.2.5)—is used to
transfer any theater load from the MMCPC-reserved directory for theater loads to TAMMAC Theater PC
cards. Once a map load resides in the MMCPC-reserved directory, it may be written to PC cards as many
times as needed. See Section 4.5 for additional information on building and writing map data.

3.3.7.3 Theater/Mission Summary (Al-BT)

This option provides an information window that summarizes all theater and mission loads currently
residing on hard disk.
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3.3.8 System

The System menu (Fig. 33) provides options for restoring color palettes to the original palettes
delivered as part of MMCPC and deleting partially processed CADRG and RDTED data.

B ACOMP Edition 1 Unlocked - MMCPC v1.0

Fil= Edit Wiew Process Log Compose Build | System Help

D = m . IC'B—L| ’? Restore Palettes

Delete Partial Process

M

Fig. 33 — System menu

3.3.8.1 Restore Palettes

This option provides the capability to restore the original set of MMCPC color palettes that were
derived from NGA source data and provided at installation. Color palettes are used to process FiAF
source GeoTIFF data into CADRG.

3.3.8.2 Delete Partial Process

This option deletes map files that were partially processed into CADRG or RDTED (Fig. 34).
Deleting partially processed map files is needed only when all of the following conditions are met:

Source map data has been processed into CADRG or RDTED;

The user disabled the Finalize Automatically option during processing;

The user does not wish to append more data;

The user does not wish to keep edge files partially filled with map data (Fig. 35).

Note: A user may wish to delete partially processed map files when, for example, FiAF processed
CADRG data will be combined with NGA CADRG for adjoining regions (Fig. 36). By deleting the
edge map files, no unfilled gap between edge files will exist between the two different sources such
as FiAF and NGA.
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ACOMP Edition 1 Unlocked - MMCPC v1.0
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Fig. 35 — Two adjoining CADRG regions (from the same source provider) with partially
filled map files. The overlay grid represents extents of individual map files.
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Fig. 36 — Two adjoining CADRG regions (from different source providers) with no
partially filled map files. The overlay grid represents extents of individual map files.

3.3.9 Help

The Help menu (Fig. 37) provides information about errors, warnings, and other messages issued by
MMCPC, and general information about MMCPC.
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File Edit Wiew Process Log Compose Buld System | Help

D = E | |E.&DF|G j |'I:12.5k j Histary Display ; ;ﬁ
| . About MMCPC

m

Fig. 37 — Help menu

3.3.9.1 History Display

This option displays the MMCPC history log file (Fig. 38), which includes all errors, warnings, and
other messages issued by MMCPC. To print this file (while it is displayed in the History Log window),
go to the File menu and click on Print (Section 3.3.1.7), or type Ctrl-P or Alt-FP.

=

M History Log:

Warning
MMCPC
|Unable ta make dataframe from image [C:\MMCPChimporthfal. gif] in filelmpE =pl)

Fig. 38 — MMCPC history processing log file

3.3.9.2 About MMCPC

This option displays technical point of contact information and the MMCPC release statement
(MMCPC version 1.0.1 only).
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4. COMMON OPERATIONS
4.1 Common Operations Overview

Most MMCPC users will be concerned primarily with using the composition functions to develop
TAMMAC theater or mission map loads based on a particular region of interest. A smaller community of
users will also utilize the map data processing functions to generate the map data required to develop
TAMMAC map loads. The following sections step through frequently used key operations. Sections 4.2
and 4.3 cover administrative functions of logging map data and generating map data in MMCPC.
Common mission planning operations are addressed in Sections 4.4 through 4.7. Note: this is not a
comprehensive list of all functions supported by MMCPC.

4.2 Logging Map Data
This section lists steps for logging map data. See Section 3.3.5 for additional information on Log

menu options. All map data sources (except data frames) must be logged (Fig. 39) before any mission or
theater compositions can be built. Map data sources are logged in one of two ways:

e Automatically: after processed map data is finalized, MMCPC logs all finalized and processed map
data residing on the hard disk.

e Manually: through a function call, MMCPC provides the capability to log map data sources that do
not reside on hard disk via the Log menu.

Frocess Menu Lag hdenu

¥

Specify Source data:

FiAF GeoTiff & DTED, I Frevioushy
]
NGA OTED, processed data
D=ata Frames on hard disk?
h
Spedfythe atternate Map data is lagged

hap data iz location of processed

automatically logged source data
after processing is
finalized

Fig. 39 — Logging data sources

Perform the following steps to log data into MMCPC:

1. Insert a valid NGA CADRG / NGA CIB / RDTED CD-ROM into the CD-ROM drive. Note:
MMCPC can log valid map data from any location accessible via the standard Windows browse
function.

2. From the main menu, click Log, then Log Source, or type Ctri-L or Alt-L (Section 3.3.5.1). MMCPC
will display a browser for defining the directory path to the data. For example, when using CIB data
from a CD-ROM drive (Fig. 40), use the browser to locate the CD-ROM drive.
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3.

Verify that a checkmark appears next to the Found Valid Source Data box and that the correct label
name appears.

Click the Log button to log the data. Logged data sources will be named by their volume identifier
(e.g., CDRGXGNCINCN 9). For automatically logged processed map data, MMCPC assigns an
identifier once the map data has been processed and finalized (e.g., CDRGFIAF0001_A).

File Edit Wiew Process Log Compose Build Swstem Help

- = RS N [ B O3\ x| &

Select Data to be Logged: o
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¥ Found Yalid Source Data

=

Processed Data Mame: |CDORGGNCINCN 9 [y 6?5' Lo

Cancel

I

¢

Fig. 40 — Log data browser

4.3 Data Processing

This section lists the steps for processing DTED and FiAF GeoTIFF data into TAMMAC-ready

RDTED and CADRG formats.

4.3.1 Process DTED into RDTED

Perform the following steps to process DTED into the TAMMAC-ready RDTED format:

1.
2.
3.

Load a DTED CD-ROM in the CD-ROM drive of the computer.
Click Process, then RDTED (or type Ctrl-D).

A window appears prompting the user to select the source and destination directories for processing
(Fig. 41). Use the top Browse button to navigate to the CD-ROM drive. Verify that a checkmark is
displayed next to Found Valid Source Data.

Select a destination directory (the default is CAMMCPC\DATA\RDTD) for the processed RDTED,
and click on Open.

An RDTED Processing window is displayed (Fig. 42a). Note the listing of source DTED files under
both the 150m and 750m tabs. The same DTED files are used to create both resolutions (150m and
750m) of RDTED. Click View Coverage to show the approximate RDTED coverage that will result
from processing this DTED source (Fig. 42b). NOTE: The user can zoom into the area of interest via
right-mouse click, then clicking on Zoom by Stretch Box (Fig. 4).

Click View Text to return to the previous view.
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7. 1If the user plans to append more DTED data for processing, unclick Finalize Automatically. If not,
verify that Finalize Automatically is selected, and determine whether to keep or remove unfilled
(partial) map segments (Figs. 35 and 36).
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Fig. 41 — Process DTED data browser
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Fig. 42 — RDTED Processing windows: (a) Text information; (b) View coverage.

Advanced ‘ Cancel ‘ Help

8. Click Process (Fig. 42a) to begin processing the DTED into RDTED files.

9. When a message is displayed stating the RDTED processing has completed, click OK. If Finalize
Automatically was checked, the RDTED that has just been processed is automatically logged in
MMCPC and is available for use in composition development. RDTED data must be finalized before
the data can be used by any other function in MMCPC. RDTED can be finalized in any of the
following ways:
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Select Finalize Automatically in the RDTED Processing window.

b. If unfinalized RDTED exists on MMCPC and the user wishes to keep partial RDTED map files
and finalize, click Process, then RDTED, then Finalize (Fig. 43).

c. Ifunfinalized RDTED exists on MMCPC and the user wishes to delete partial RDTED map files
and finalize, click System, then Delete Partial Process, then RDTED (see Section 3.3.8.2).

d. If unfinalized RDTED exists on MMCPC and the user wishes to process more DTED data, click
Process, then RDTED, then Append (Fig. 43). Verify the Finalize Automatically button is
selected when processing the last set of DTED data.

Bl Rdted Finalization

P Unfinalized Rdted exists on the swskem

‘fou miusk either finalize the remaining map files currently on disk ar
apppend map data to the exiskting unfinalized Rdeed

Append ! Finalize Cancel

Fig. 43 — RDTED Finalization window

4.3.2 FidAF Geotiff Processing

This section describes the procedure for processing FiAF GeoTIFF images into the TAMMAC-ready

CADRG format.

1.

Insert a CD-ROM containing FiAF source GeoTIFF data in the CD-ROM drive. In MMCPC, click
Process, then CADRG (or type Ctrl-G).

A window appears (Fig. 44) prompting the user to select the source and destination directories for
processing. Use the top Browse button to navigate to the CD-ROM drive of the computer. Verify that
a checkmark is displayed next to Found Valid Source Data.

The default destination directory for processing CADRG data is C:\MMCPC\DATA\CDRG. Click
Open. Wait a few moments while MMCPC reads the FiAF GeoTIFF data from the CD-ROM.

If the source map data contains custom color palettes, a message is displayed to inform the user that
new color palettes were detected for the appropriate map scales and note the possible repercussions of
installing new color palettes (Fig. 45). Note: MMCPC does not unlog or remove obsolete map data
from the system. This message informs the user that if the new data to be processed is meant to
replace another set of processed CADRG, then the user should remove the obsolete data via the
Unlog function. Click Continue to use the modified color palettes.



34 Myrick et al.

Source Data Directory:
Jon
[F FoundValid Source Data

Browse

-

[ estination for Processing Directory:: l}) /

Cvmmcpchdata\CORG @ .
1 Browse i L m

X

s
i-

i

Cancel Help !

Fig. 44 — Process CADRG data browser
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Fig. 45 — Color palette informational message

5. A CADRG Processing window is displayed (Fig. 46). Note the listing under each map scale tab
contains GeoTIFF files specifically for those map scales. For CADRG processing, each GeoTIFF file
is processed for only the scale for which it is associated. Click View Coverage to show the
approximate CADRG coverage that will result from processing these FIAF GeoTIFF source files.
Click through each of the scale tabs to see the coverage for each scale.
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10.
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Fig. 46 — CADRG processing windows: (a) Text information; (b) View Coverage.

Click View Text to return to the previous view. If only one FiAF GeoTIFF source CD-ROM will be
used for processing, verify that Finalize Automatically is checked. Enter the User Given Name (a
descriptive title provided by the user). Note: The same processing rules apply as listed in Section
4.3.1, step 9, for finalizing RDTED map data.

Click Process to begin processing the FiIAF GeoTIFF files into TAMMAC-ready CADRG-like files.
This is a CPU-intensive process because of spatial and color compression techniques that must be
used to create CADRG files.

When a message is displayed that states the CADRG processing has completed, click OK (Fig. 47).
MMCPC automatically assigns an identification number for this data set and displays this identifier in
the completion message. Make note of this identification number since all references to this processed
map data throughout MMCPC will be made by its identification number.

To verify all the required map data has been logged and properly processed, perform the following
steps:

a. From the MMCPC main window, click Compose, then Include Coverage, then Logged Source.

b. Verify the logged source listing includes all sources that have been logged and processed (Fig.
48).

View the map data by double-clicking on a record in the list. Set the MMCPC Data Type and Scale to
appropriate settings (Fig. 49a) and move the cursor over an area of processed coverage. Right click
and select View RPF Data (Fig. 49b). Close the review window.

Once each source has been verified, by repeating steps (1) through (3), click File and then New on the
main MMCPC window. When prompted to save the current composition, click No to restore
MMCPC to its initial state.
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4.3.3 Data Frame Processing

This section describes the procedure for processing data frames.

1.
2.

From the MMCPC main window, click Process, then Dataframe.

On the Dataframe Viewer window (Fig. 50a), click File, then Open Image File. Image files may be
located in the default directory (C:\MMCPC\IMPORT) or the user can browse to the required
directory for the source image files. Source image file types supported in MMCPC are: gif, bmp, jpg,
png, and hdf (TAMMAC format). Double click an image file to open it in the Dataframe Viewer
window. If the image file was opened and is displayed properly, it may be converted to a data frame.
Note: Source image files must be cropped to a size of exactly 768 x 768 pixels to be converted into a
valid TAMMAC data frame.

From the viewer window, click File, then Save As Dataframe. In the Save As window (Fig. 50b),
save the data frame with an appropriate file name. This will save the file as a TAMMAC-ready data
frame file. The default location to save data frames is C:\MMCPC\DATA\DATAFRAME.

Repeat steps (2) and (3) for each image file.

Verify that the data frames were properly saved by opening each one in the viewer: From the
Dataframe Viewer menu, click File, then Open Image File. Browse to the directory where the data
frames were saved (C:\MMCPC\DATA\DATAFRAME if the default was used). Double click on a
saved data frame and verify that it is correct in the viewer window.

M Dataframe Viewer M Dataframe Viewer ‘ZHE‘E‘

File: Eile

Open Image File

©Open Image File ‘
Save As Dataframe 5 )
Close

Exit

(a) open Image File (b) Save As Dataframe

Fig. 50 — Data frame processing: (a) Opening an image for viewing and processing;
(b) Saving the image as a data frame.

4.4 Map Composition and Development

This section describes several methods to design and create map compositions. A map composition

defines all geo-referenced map data to exist on its corresponding TAMMAC theater or mission map load.
Each map composition is a set of user-defined regions of interest that may span multiple data types
(CADRG, RDTED, CIB) and map scales. The methods described below may also be used in combination
to create a composition.
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4.4.1 Define a Composition Using Logged Sources

1. From the MMCPC main menu, click Compose, then Include Coverage, then Logged Source (Fig. 48).

2. Verify the map coverage:

a. Double click on a source (e.g., CADRG) and verify that map coverage over the appropriate
geographic area is displayed (Figs. 49a and 49b). Note: A logged source will contain only a
single data type (CADRG, RDTED, or CIB) but may contain multiple map scales for that data
type (e.g., CADRG: 1:250k, 1:500k, and 1:2M). If RDTED is included in a composition, both
map scales (150m and 750m) must coexist for the region of interest selected. In other words, the
user cannot choose to include only 150m RDTED without 750m RDTED.

b. Repeat for each source data type and scale. Note that the user may need to adjust settings in the
MMCPC Data Type and Scale boxes (Section 3.2.2.2).

3. From the MMCPC main window, click File, then Save. Enter a composition name. The composition
will be saved as an unlocked composition. Click OK.

4. From the main window, click File, then Close.

5. From the main window, click File, then Open. Double-click on the newly saved composition and
verify that all map data (of all types and scales) included in the composition was properly saved.

6. From the main window, click Compose, then Verify Composition (Section 3.3.6). Click the radial
button for Theater (Fig. 51). Verify that the current composition is a valid theater map for TAMMAC
and the number of map cards needed.

NOTE: The calculation used to determine maximum theater/mission size, theater card size, and
mission card size are defined in a configuration file that may be modified as PC card sizes change.
The current maximum capacity setting for theater map cards is 1.0 GB. The current maximum
capacity setting for mission map cards is 256 MB.

7. Once verified, click File, then Close.

B MMCPC 2)X

Yernfying current Compozition. ..

f* Theater i Mizzion

Walid Theater Composzition,
the number of cards needed is 2.

....................................

Fig. 51 — Verification of current theater composition
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4.4.2 Define a Composition Using Another Composition

1. From the MMCPC main window, click Compose, then Include Coverage, and then Composition.
Double-click a composition name.

2. From the MMCPC main window, click File, then Save. Enter a composition name. The new
composition will be saved as an unlocked composition. Click OK.

3. From the main window, click File, then Close. Verify the composition has been closed.

4. From the main window, click File, then Open. Double click on the newly saved composition. Verify
that all of the map data included in the composition was properly saved. This new composition should
contain exactly the same map coverage as the composition that was included.

5. From the main window, click Compose, then Verify Composition (Section 3.3.6). Click the radial
button for Theater (Fig. 51). Verify that the current composition is a valid theater map for TAMMAC
and the number of map cards needed. If the composition is too large, the user may remove coverage
via the Erase an Area of Coverage function (Section 3.2.2.4.2).

6. Once verified, click File, then Close.

4.4.3 Define a Composition Using the MMCPC Composition Toolbar

1. From the MMCPC main window, click File, then New.

2. Show all available map coverage by clicking View from the main menu, then Available Coverage. A
checkmark will then be displayed next to this selection showing that it has been toggled on (Section
3.3.3.3). Using the Data Type and Scale drop-down menus (Section 3.2.2.2), click through each data
type and map scale selection. Note that the color of the map coverages shown is green (Fig. 52). This
indicates that the coverage shown is available but not part of the current composition (map segments
are displayed in red for compositions).

3. Use the Zoom-in on a Stretch-Box tool (Section 3.2.2.3) to zoom into a region of interest. Once the
button has been clicked, the cursor should change from an arrow to a cross (+). Depress the left
mouse button at the upper left corner of the region of interest and drag to the lower right corner of the
area to create the desired zoom box.

4. Click the Zoom-in on a Stretch-Box tool again to return the cursor to an arrow.

5. Select a Data Type and Scale (e.g., CADRG data at 1:5M scale). Green map segments should be
displayed for the entire areas of existing available coverage.

6. Use the Define Coverage by a Stretch-Box tool (Section 3.2.2.4) to select an area. Depress the button
to activate the function, hold down the left mouse button at the upper left corner of the region of
interest and drag to the lower right corner of the desired coverage. A purple box will be displayed
showing the extents of the stretch-box, and the color of the map segments within the intersecting box
should now be red (indicating that these map segments are part of the current composition, Fig. 53a).

7. The map scale can be changed to include additional data at other scales by repeating step (2) for each
scale.

8. The data type can also be changed to include additional data types (e.g., RDTED). If needed, use the
Zoom Qut tool to see all of the available coverage.

9. Use the Erase Coverage by a Stretch-Box tool to remove unwanted coverage (Section 3.2.2.4.2).
Depress the button to activate the function, hold down the left mouse button in the upper left corner of
the region of interest and drag to the lower right corner of the desired coverage. A purple box should
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10.

be displayed showing the extents of the stretch-box, and the map segments within the box will now be
removed (Fig. 53b).

Note regarding different scales within each data type: Actions taken at one scale are not automatically
applied to the others. Verify that any changes on one scale do not adversely affect the coverages of
another. The one exception is RDTED. All actions (adding or deleting RDTED map coverage) always
apply to both scales (150m and 750m).

To associate data frames with a composition:

From the main window, click Compose, then Associate DF'.

b. A Select Dataframes window will be displayed. Data frames residing in the default directory
(C:\MMCPC\DATA\DATAFRAME) will be listed.

c. Select a data frame(s) by clicking on the file name(s). Click Open to associate the data frames. A
list of associated data frames (Fig. 54) can be viewed from the tool bar (Section 3.2.2.6).

d. From the MMCPC main window, click File, then Save. Enter a composition name. The
composition will be saved as an unlocked composition. Click OK.

e. From the main window, click File, then Close.

I8 Untitled - MMCPC v1.0
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Composing Mode

Fig. 52 — Area of available coverage for a new composition. The green-colored grid indicates that
the coverage is available but is not yet part of the current composition.
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I FINLAND1 Edition 1 Unlocked - MMCPC v1.0
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Fig. 53 — Defining a composition area of coverage. (a) Defined coverage area is red, available data is green;
(b) a portion of coverage is erased to redefine the composition area.
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Fig. 54 — List of associated data frames

4.4.4 Create a Mission Composition via MPS File

The Mission Planning System (MPS) import is an ASCII file that serves as an interface between the
MPS system and MMCPC. The MPS import can be used to create a composition and process data frames
in MMCPC based on the contents of the MPS-ASCII file.

1. From the MMCPC main window, click View, then Available Coverage (toggle on) to view all logged
map coverages. Then, from the main window, click File, then Import.

2. A window is displayed to select an import file (Fig. 55). Click Import from MPS.

3. A window is displayed to select the MPS file for import (Fig. 56). The default import directory is
C:A\MMCPCAMPORT. However, the user may browse to another directory to locate the import file.
Double click on the file name to select it. Import files must contain a “.mps” suffix for the filename.

4. MMCPC will create a composition based on the data types, map scales, and extents that are listed in
the newly imported MPS file.

NOTE: The resultant composition will contain only the MPS-requested map coverage that is
available in the existing logged sources. Consequently, some of the data that has been requested in an
MPS file may not actually exist and so cannot be included in the composition. To check if this is the
case, compare the available coverage (shown in green) to the MPS coverage (shown in red). If an
MPS composition is not generated, this indicates that MMCPC does not have corresponding logged
data sources.
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Fig. 56 — MPS import file browser

5. Verify the data frame(s) listed in the MPS have been processed and associated with the current
composition by reviewing the list of data frames in the Associated Dataframes tool bar (Fig. 57).

6. From the main window, click Compose, then Verify Composition. Click the radial button for Mission.
Verify the current composition is a valid mission map for TAMMAC (Fig. 58). If the composition is
too large, the user may remove coverage via the erase coverage functions on the tool bar (Section
3.2.2.4).

7. When verified, click File from the main menu, then Save. The name of the composition is provided in
the MPS file and will be displayed as the default name to save. Click OK.

8. Click File, then Close.
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B ATP4 Edition 1 Unlocked - MMCPC v1.0 =13
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Fig. 57 — Composition with data frame created from an import MPS file
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Fig. 58 — Verification of current mission composition

4.5 Map Theater and Mission Build

This section includes methods to build and write TAMMAC-ready theater data loads and to build
mission data loads from compositions (Section 3.3.7). The TAMMAC-ready theater data loads include
the FiAF-released TAMMALC files containing configurable parameters and symbol set files.

In MMCPC, all data loads are first written to hard disk. Theater loads may then be written to
TAMMAC Theater PC cards. Mission loads require an additional file that is provided by the MPS
system—MMCPC assumes that the MPS system will read mission loads from the hard disk, apply the
additional file needed and then write the mission load to a TAMMAC Mission PC card.

The theater map—specific files include an ARC.DAT file, a TIF.DAT header file, which is associated
with each ARC.DAT (if spanned over multiple PC cards), a DIR.DAT directory list file associated with
each ARC.DAT file, and a CONFIG.HRS F/A-18 configuration file. The mission map load does not use
ARC.DAT. Individual map files are written to the PC card and, since mission loads are very small, they
will always be contained on a single PC card. The mission-specific files include individual map data files



44 Myrick et al.

(CADRG, CIB, RDTED, data frames), DIR.DAT and TIF.DAT. This build does not include MF.DAT,
which must be built by the MPS system to create a valid mission load to PC card.

The PC card size for map cards is significant because a theater load may span multiple cards. When
this is the case, the data structure containing map files for a theater load must be sized to fit each card.
MMCPC reads a parameter file that specifies the card size. Should the card size increase in the future, this
parameter file will require modification.

4.5.1 Build TAMMAC Map Loads

1. From the MMCPC main menu, click Build, then Build Map (Fig. 32). A Build Map window is
displayed (Fig. 59). If a composition is open, the user will be prompted to save it before the Build
Map window is displayed. The open composition will be the default composition shown in the Build
Map window. However, the user may click Browse and choose any other non-obsolete composition
that exists within MMCPC (Fig. 60).

2. Click either the Theater or Mission radial button on the Build Map window to indicate which map
build type is required (maximum of 3 GB for theater or 256 MB for mission). Once the map build is
complete, the corresponding composition will be locked for that build type (theater or mission).

3. The Build Map window then closes and the Data Sources window is displayed (Fig. 61). This
window shows all possible map sources for the selected composition. Click OK to accept the default
order of sources.

r - |
I Build Map ?x
Build Type:
v Theater " Mission

Browse
Ok | Cancel ‘

Fig. 59 — Build Map window
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M Select Composition ...
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ATP4 o UnLacked
bComp m Locked
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FIMLAMDA ] UnlLocked

Composition Mame : |

Composition Type |AII j
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Fig. 60 — Build map composition browser

M Data Sources Needed:

Id Path

C\mmcpchcoveragehloggedt CE 105000737, rif
C:hmmopchooveragetloggeds CBOSMP35001 rif
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C:hmmepchooveragetloggedsR D TOFIAFOD0E_A rif
Chmimepchooveragetloggedt CORGXSPRIJOGAZ_1.nif
C:hmmepchooveragetloggedy CORGXOMCTPCOS_8 rf
C:hmmepchooveragetloggeds CORGHGMCIMCM_9.nf
Cvmmcpchcoveragehlogged \ CORGFIAFO00Z_a rif

N 3

Up Down

Fig. 61 — Build map data sources window

NOTE: Map data sources may have overlapping coverage. The Data Sources window allows the user
to set the order of precedence of the data sources that will be used to construct the map build (top is
highest priority). Order of precedence may be important when newer map data overlaps older data or
when prioritizing the source provider (e.g., use FiAF data before NGA data). The user may change
the order of precedence by clicking (i.e., selecting) a particular source and using the Up and Down

buttons to set the order.

If data frames are associated with the composition, another window will be displayed showing the list
of data frames (Fig. 62). As noted above, the order of precedence may be changed via the Up and
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Down buttons. The order of precedence for data frames will determine the order in which the data
frames are displayed in the aircraft (top is displayed first). Click OK.

B Data Sources Needed:

Id Path
C:vmmepehdatabdataframe\DREVIL hdf
C:vmmepetdatabdataframetFAF. hdf

i i
L]

Fig. 62 — Build map data frame sources window

5. The build process will begin. For sources on CD-ROM, MMCPC requests the user to insert the CD-
ROM or to locate an alternate location (Fig. 63) and click OK to continue. When the window appears
indicating the build is complete, click OK (Fig. 64). All TAMMAC theater map loads are saved to
C:\MMCPC\TAMMAC\THEATER and all TAMMAC mission map loads are saved to C:\MMCPC\
TAMMACMISSION. The Mission Planning System is expected to read and/or copy the appropriate
mission load from the MMCPC mission directory. MMCPC will write TAMMAC theater loads as
discussed in the following section.

F

Il MMCPC

Pleaze verfy that 'CE105000731" iz at the below lozation, or specify where it can be found:

Cancel |

Fig. 63 — Build map data source locator

B Map Build. .. X

Zompleted building ACOMPOL,

Fig. 64 — Build map completion message
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4.5.2 Write TAMMAC Theater Loads to PC Card

1. From the MMCPC main window, click Build, then Write Theater Map (Fig. 32). Double click on the
name of theater map to be written (Fig. 65). Note that the map load name is the same as its
corresponding composition, including its two-digit edition number.

M Select Map Build ...

Map Build Mame :  |ACOMPOT

tap Build Type : j Theater _:_J

Cancel l

Fig. 65 — Write theater map browser

2. A window is displayed that asks the user to enter the serial number of the first PC card (Fig. 66).
Enter the serial number, insert this card into the PC card drive, and click OK. The PC card drive (e.g.,
drive E:) is pre-configured at MMCPC installation.

Enter the nest card'z B digit zenal number and inzert into drive [E:4).

()4 Cancel

Fig. 66 — PC card window
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3. When the write operation requires a single card load, click OK after the write has completed. Eject the
card from the PC card drive and label this card with a descriptive title.

4. When the write operation spans multiple cards, the user will be prompted after the first card has
completed to enter the second card’s serial number and to insert the next card. Eject the first card and
label it with a descriptive title, enter the serial number of the next card, and insert it into the PC card
drive. Repeat for each additional card.
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ASCII
ATP
CADRG
CIB

DF
DTED
FiAF

GB
GEOTIFF
GTIF
HDF
MASCII
MMCPC
MPS
NAVAIR
NGA
NRL
PCMCIA
RDTED
RPF
TAMMAC

Appendix A

ACRONYMS AND TERMS

American Standard Code for Information Exchange
Acceptance Test Procedures

Compressed Arc Digitized Raster Graphics

Controlled Image Base

Data Frame

Digital Terrain Elevation Data

Finland Air Force

Gigabytes

Geo-referenced Tagged Image File Format

Geo-referenced Tagged Image File Format (as used in Fig. C1)
Harris Data Frame

Modified American Standard Code for Information Exchange
Moving-Map Composer—Personal Computer

Mission Planning System

Naval Air Systems Command

National Geospatial-Intelligence Agency

Naval Research Laboratory

Personal Computer Memory Card International Association
Regridded Digital Terrain Elevation Data

Raster Product Format

Tactical Aircraft Moving-Map Capability
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Appendix B

MODIFIED ASCII SYMBOL SET

Code (Decimal) | Character | Code (Decimal) | Character | Code (Decimal) | Character
0 Space 43 % 87 reserved
1 A 44 , 88 reserved
2 B 45 ° 89 reserved
3 C 46 . 90 reserved
4 D 47 / 91 reserved
5 E 48 0 92 reserved
6 F 49 1 93 reserved
7 G 50 2 94 reserved
8 H 51 3 95 reserved
9 I 52 4 96 reserved
10 J 53 5 97 reserved
11 K 54 6 98 reserved
12 L 55 7 99 reserved
13 M 56 8 100 reserved
14 N 57 9 101 reserved
15 O 58 = 102 reserved
16 P 59 reserved 103 reserved
17 Q 60 reserved 104 reserved
18 R 61 reserved 105 reserved
19 S 62 reserved 106 reserved
20 T 63 reserved 107 reserved
21 U 64 reserved 108 reserved
22 \ 65 reserved 109 reserved
23 A\ 66 reserved 110 reserved
24 X 67 reserved 111 reserved
25 Y 68 reserved 112 reserved
26 Z 69 reserved 113 reserved
27 \ 70 reserved 114 reserved
28 reserved 71 reserved 115 reserved
29 reserved 72 reserved 116 reserved
30 reserved 73 reserved 117 reserved
31 reserved 74 reserved 118 reserved
32 reserved 75 reserved 119 reserved
33 « 76 reserved 120 reserved
34 ? 78 reserved 121 reserved
35 : 79 reserved 122 reserved
36 # 80 reserved 123 reserved
37 - 81 reserved 124 reserved
38 + 82 reserved 125 reserved
39 ‘ 83 reserved 126 reserved
40 ( 84 reserved 127 reserved
41 ) 85 reserved N/A N/A

42 * 86 reserved N/A N/A
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Appendix C

SOURCE MAP DATA AND DIRECTORY STRUCTURE FORMAT

C1. FiAF GEOTIFF FILE FORMAT AND DIRECTORY STRUCTURE

MMCPC 1.0 supports GeoTIFF files that conform to the GeoTIFF Format Specification version
1.8.1. For Finnish GeoTIFF map data, MMCPC supports both Model Transformation Tag and Model
Pixel Scale / Model Tiepoint Tag geocoding.

For MMCPC to identify and process source media, all FIAF GeoTIFF CD-ROMs must have a
volume identification of FAF_GTIF. Otherwise, MMCPC will not process the map data. The producer of
GeoTIFF source data is responsible for providing the CD-ROM volume identification.

A FiAF GeoTIFF CD-ROM may contain any number of GeoTIFF files for multiple map scales and
one optional custom color palette file for each map scale that contains GeoTIFF files. All GeoTIFF files
must contain a TIF suffix (e.g., ABCDEFGH.TIF) and all files must conform to the directory structure
shown in Fig. C1.

(root directory)
/FAF_GTIF

/5M /2M /1M /500k /250k /100k /50k /12k

i Lﬂ”w” Lﬂ “tif Li_lﬂ waif || [ ~uf

Fig. C1 — FiAF source GeoTIFF directory structure
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C2. FiAF DTED FORMAT

MMCPC 1.0 will support only DTED level 1. DTED level 1 post (elevation) spacing is defined in
Section 3.9 of the DTED military specification MIL-PRF-89020A.

The directory structure and file naming convention of FiAF DTED must conform to the format
defined in the DTED military specification, Section 3.14.2, with the exception that FiAF DTED is not
required to have a gazetteer, a DMED file, text files, or the GAZETTE or TEXT directories.



Appendix D

FiAF CUSTOM COLOR PALETTE

D1. INTRODUCTION

This section describes the installation and format of custom color palettes for use by MMCPC when
source FiAF GeoTIFF files are processed into CADRG-like files (required for compatibility with the
TAMMAC Digital Map System). The color palette is an ASCII file containing a maximum of 216 colors
as shown in Fig. D1. Color palettes are used by MMCPC to transform source GeoTIFF files from 24-bit
color to 8-bit color (i.e., color compression). MMCPC is originally installed with a default set of 8 color
palettes (one for each map scale supported: 1:5M, 1:2M, 1:1M, 1:500k, 1:250k, 1:100k, 1:50k, and
1:12.5k) that are derived from NGA source CADRG files.

Custom color palettes are automatically installed by MMCPC during processing of FiAF GeoTIFF
data (into CADRG). A custom color palette must reside in the appropriate scale directory along with the
set of GeoTIFF files to be processed. Only one color palette per scale is allowed and it must be named
PALETTE.TXT. Once data processing begins, the custom color palette will replace the current default
color palette for that particular map scale. The custom color palette now becomes the new default palette
for that scale and will subsequently be used to color compress the source GeoTIFF files at that scale into
CADRG files. A PALETTE.TXT file may exist in each map scale directory that contains GeoTIFF files.
To reduce the impact of color loss during processing, custom color palettes that provide good
representations of the true colors of the source data should be used.

D2. FiAF COLOR PALETTE FORMAT

MMCPC requires that a custom color palette file follow a specific format (Fig. D1). The first line of
the color palette file must contain the number of colors being defined. The maximum number of colors is
216. If the actual number of colors does not match the number listed in the first line, the file will be
considered invalid and the map data will not be processed. After the first line, each successive line must
contain the text “Set x,” where “x” is the numeric identifier of the color (e.g., “Set 216”). These numbers
should be consecutive. The “S” in “Set” must be capitalized. Following this text, the red, green, and blue
components (valid values 0-255) for the color follow, with each value delimited by a single space. In Fig.
D1, each space is shown as *

Fig. D1 — FiAF custom color palette format
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Appendix E

MPS IMPORT FILE FORMAT

The MPS import is an ASCII file that serves as an interface between the MPS system and MMCPC.
The MPS import can be used to create a composition and process data frames in MMCPC based on the
contents of the MPS-ASCII file. All MPS import files must end with an extension of “MPS”.

MMCPC reads the MPS import file (defined below) and creates an MMCPC composition from the
file’s contents. The user may import an MPS file into MMCPC from any available directory or hard drive.
Further, source files for data frames listed in an MPS file may exist in any available directory or hard
drive available to MMCPC. However, a full path name for each data frame is required.

All source files for data frames must be 768 x 768 pixels in size as required by TAMMAC. Resultant
mission builds are stored in a predetermined and permanent directory on MMCPC, namely,
C:\MMCPC\TAMMACMISSION. A file folder will exist with the name given in the MPS file. All
required files for a valid TAMMAC mission load will exist within this directory EXCEPT for the
MF.DAT file, which must be created by the MPS system. The MPS import file format is shown in Fig. E1
and is comprised of three sections: header, data, and location. Figure E2 presents an example of an import
file.

The header section contains the unique mission name that will be assigned as the MMCPC
composition name. The maximum name length is 10 characters and it cannot include spaces or special
characters. This is accompanied by an integer that indicates the number of data sections to follow. An
exclamation point (!) in the first column indicates that the line is a comment field and the entire line is
ignored during import.

The data section consists of information to identify the map data type, map scale, and
source/destination directories for data frames. Valid map data types include CADRG, CIB, RDTED, and
DF (data frames). Valid map scales for these data types are listed in Table E1. Source and destination
paths for data frames must specify the full directory path and file name. For example, a source destination
could be C:\AMMCPC\IMPORT\TEST.GIF.

The location subsection is applicable to CADRG, RDTED, and CIB data types. The first entry in this
section lists the number of coordinates that will follow for that particular data section (e.g., CADRG @
1:2M). This is accompanied by a series of latitude and longitude coordinates that are specified in +/-
decimal degrees and delimited by commas.
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{Header section}
<Unique ldentifier> (e.g. MPS0001)
{Data section}
<Data Type> (CADRG, CIB, RDTED, DF)

<Scale> (Applicable for CADRG and CIB only)
<Source path and filename> (Applicable for DF only)

<Destination path and filename> (Applicable for DF only)

<Number of lat / lon points>

{Location subsection} (CADRG, CIB, or RDTED with max. of 256 defined points)

<Lat, Lon> (Decimal degrees [dd.ddd,ddd.ddd])

}
}

I Indicates comment field

Fig. E1 — MPS Import file format

Table E1 — Valid data types and map scales

Data Type

Map Scale

CADRG

1:12.5k

1:50k

1:100k

1:250k

1:500k

1:1M

1:2M

1:5M

RDTED

150m

CIB

Sm

10m
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ATP4

! Composition title

5

! Number of sections to follow

! CIB has 2 scales [5m (5 meter) 10m (10 meter)]
CIB

Sm

4

61.5,024.5

62.5,024.5

62.5,025.5

61.5,025.5

! CADRG has 8 scales [1:12.5k,1:50k,1:100k,1:250k,1:500k,1:1M,1:2M,1:5M]
CADRG

1:250k

4

61.5,024.5

62.5,024.5

62.5,025.5

61.5,025.5

CADRG

1:2M

4

61.5,024.5

62.5,024.5

62.5,025.5

61.5,025.5

! Both scales of RDTED 750m and 150m are always included
! Always specify 150m

RDTED

150m

4

61.5,024.5

62.5,024.5

62.5,025.5

61.5,025.5

! Data frames - specify source dir and name / destination dir and name.
! DF

! C:AMMCPC\import\STOOGIES.GIF

! C:\MMCPC\data\DATAFRAME!\stoogies.hdf
DF

C:\MMCPC\import\faf.gif
C:\MMCPC\data\DATAFRAME\FAF.hdf

Fig. E2 — MPS import file example (MPSIMPORT.MPS)





